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1.  AIMS OF THE TOOLS 

An important component of MORE is the use of extensive stakeholder engagement, to encourage 
the co-creation of design options in each of the case study areas.  
 
Buchanan Computing (BC) has developed two software tools, based on enhancements of its 
Traffweb and LineMap software, to provide cloud and web-based engagement tools. In addition, 
UCL has developed a physical Street Layout Toolkit, using blocks and acetates. 
 
Stakeholder engagement consists of three types of consultation: 
 

• Issue Consultation: collect issues, suggestions and comments regarding the current situation 

within the study area, using Traffweb. 

• Design option development: co-creation workshops, using blocks and acetates, to generate 

design options, for wider consultation and assessment, then imported into LineMap, where 

professionals can refine designs. 

• Design Consultation: feedback on design(s) for the improvement of the study area, using 

Traffweb. 

 

The Street Layout Toolkit facilitates the street design process, by: 

 

1. Illustrating the kinds of street design elements that might be included in the designs 

2. Enabling design group members to explore different design options for a section of street 

3. Ensuring that the designs are technically feasible, as the design elements are drawn to scale 

 

Traffweb (www.buchanancomputing.net/traffweb), the web-based component allows cities to: 
 

1. Collect data from stakeholders relating to issues and feedback during Issue Consultation. 

2. Collect data from stakeholders relating to designs and feedback during Design Consultation. 

3. Provide feedback on stakeholder engagement via a secure interactive dashboard and 

downloadable reports 

 

LineMap (www.buchanancomputing.net/linemap), the cloud based design component: 
 

1. Allows city designers to create digital representations of improved road space designs. These 

designs can then be: 

a. Printed onto paper for use in Local Workshops 

b. Published to Traffweb for online Design Consultation 

2. Allows the digitisation of paper designs created during Local Workshops 

3. Allows the definition of study area extents and definition of the feeder route on a map 

display 

4. Has the ability to define road space as road markings or coloured blocks (replicating the 

physical street design tool) 

 

The figure below sets out the overall stakeholder engagement process. 

https://eur01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.buchanancomputing.net%2Ftraffweb&data=04%7C01%7Cp.anciaes%40ucl.ac.uk%7C1737ebb7975c449d93e908da082f6990%7C1faf88fea9984c5b93c9210a11d9a5c2%7C0%7C0%7C637831297281962699%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000&sdata=si2%2FJ9AurWv3aTmFdiHbW8tE5t241xU3WYXO6pUOOaw%3D&reserved=0
https://eur01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.buchanancomputing.net%2Flinemap&data=04%7C01%7Cp.anciaes%40ucl.ac.uk%7C1737ebb7975c449d93e908da082f6990%7C1faf88fea9984c5b93c9210a11d9a5c2%7C0%7C0%7C637831297281962699%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000&sdata=tGx0%2BdEHk9jinaz1YFUeIeC4Bib81OcAirptBTltkRE%3D&reserved=0
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The Stakeholder Engagement Process 
 

 
 
 

Traffweb: Issue 
Consultation

Street Layout Toolkit:            
Generate design options

LineMap: Professional input 
to further refine designs

Export designs to VISSIM for 
modelling, plus appraisal

Link VISSIM models and 
images to Designs 

Publish Designs to Traffweb 
for Public Consultation

Analyse Comments from 
Consultation



 

   D4.6 Tools for Stakeholder Engagement  4  ©2021 MORE & Buchanan Computing   

2.  GENERAL STRUCTURE OF THE TOOLS 

The Street Layout Toolkit is used to co-create street design options with a wide range of stakeholder 
groups.  

• Inputs: 
o Street design brief, including feedback from Issue Consultation 

• Outputs: 
o Annotated physical design options using coloured and shaped labels 

 
LineMap is used to create and enhance design options by city designers and other professionals.  

• Inputs: 

o Outputs from Street Layout Toolkit 

o Street design brief, including feedback from Issue Consultation 

o Options generated in MORE Task 4.1 

• Outputs: 

o Digital design options, displayed as road markings or as coloured blocks 

 
Traffweb is used for stakeholder engagement during Issue and Design Consultation phases.  

• Inputs: 

o Design Options created in LineMap 

• Outputs: 

o Design Options available for comment and feedback 

o Study area available for comment and feedback 

 
The figure below summarises the main inputs and outputs for the stakeholder engagement tools: 

VISSIM Road 

 Marking Export 

LineMap 
Data Transfer 

Road Space 
Designs 

Reports: 

Consultation 
Data 

Design Ideas 
from Street 

Layout Toolkit 

VISSIM Model 
links to images 
and or videos 

Traffweb 

Reports: 

Upload 
relevant 

documents  

Stakeholder 
Issues 

Stakeholder 
Design 

Feedback 

Options 

generated from 

Task 4.1 

 

Design 
Options 

Feedback 
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Other Inputs: 
 

• Stakeholders needs and requirements: 

• Multi city mapping 

• Multi language 

• Issue data collection 

• Reporting tools 

• Cater for all user types: 

• Public Stakeholder 

• City Designer 

• City Administrator 

• Dataset Requirements:  

o Open Street Map 

o Large Scale City Mapping 

o Common Issue Categories 

o Common Time of Day 

o Road space Use Types 

• Nominated City Designers 

 

Establish requirements for stakeholder engagement: 

 

• Study Area Boundary 

• Target Stakeholders 

• Consultation Period 

• Detailed (Large Scale) Mapping and copyright 

• Points of Interest or Street Gazetteer 

• Route Overview: Static Image or Data 

• Legal and GDPR notices: 

• Accessibility 

• Privacy 

• User Form: Email, Name and Postcode can be mandatory – further fields available, 
but there is the need to consider GDPR for personal information 

• Google Street View Locations 

• Street level Photos at key points in the area 

• Design Level Users: Name and email 

• Project Description for Landing Page 

• Site Translation 
 
Determine data formats required for information exchange:  
 
The following diagram outlines data and document formats for the two software tools, as well as 
relevant protocols required by various inputs and outputs. 
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LineMap Application 
Traffweb Application 

Mapping 

Store 

Consultation 

Database 
Mapping 

Design 

Database 

hyperlinks, 
jpg, png, 

pdf 

Reports: pdf, 
docx, xlsx 

etc 

MIF/MID, 
JSON 

ESRI 
Shapefile 

CSV 

https TAB files 
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The street Layout Toolkit consists of: 

• A plan of the street design exercise area, at 1:200 scale 

• A box of component blocks representing street design elements 

• A set of acetates for the larger street design elements, or those that cannot be 

represented using straight line blocks 

• A set of sticky labels, to replace the blocks once the design exercise has been competed 
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Traffweb consists of a web address:  
 

• https://www.moreconsultation.eu 

 
Each city has its own dedicated site: 
 

• https://www.moreconsultation.eu/london/ 

• https://www.moreconsultation.eu/lisbon/ 

• https://www.moreconsultation.eu/budapest/ 

• https://www.moreconsultation.eu/constanta/ 

• https://www.moreconsultation.eu/malmo/ 

 
Within each site are the following public and private pages: 

 

 
 

  

Landing 
Page

Public 
Consultation

Scheme 
Admin

Feedback 
Dashboard

https://www.moreconsultation.eu/
https://www.moreconsultation.eu/london/
https://www.moreconsultation.eu/lisbon/
https://www.moreconsultation.eu/budapest/
https://www.moreconsultation.eu/constanta/
https://www.moreconsultation.eu/malmo/
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LineMap 
 
The LineMap application is hosted in the BC Cloud and provided as Software as a Service. The 
application can be accessed via any modern browser. For access to this tool, each city has two 
generic logins. The application is accessed via a url: 
 

• https://buchanancloud.net 

 
Once logged in all LineMap functionality is accessed via a single Ribbon and Map based interface: 
 

1. Ribbon menus 

2. Interactive map 

3. Mapping shortcut menu 

4. Road Marking Explorer 

 

 

 
 
 
The map interface enables designers to digitise design options and publish them to Traffweb, as well 
as export to VISSIM. 
 

  

1 

2 

3 

4 
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3. HOW TO USE THE SOFTWARE TOOLS 

• For details of how to use Traffweb see Appendix A Traffweb Stakeholder Tool Guide 

• For details of how to use LineMap see Appendix B LineMap Training Guide 
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4.  HOW THE TOOLS WERE TRIALLED IN THE 
MORE CITIES 

The tools were trialled by means of a pilot study: 
 

Stage 

 
A Traffweb Issue Consultation (Complete – piloted by Transport for London): 
 

1. A single city was selected as the pilot for Issue Consultation to test Traffweb: 

2. A stakeholder engagement was conducted on the area as a staged event. 

3. Any initial issues were fed back to Buchanan’s and rectified ASAP 

4. Further stages of the engagement were conducted. 

5. Stakeholder comments concerning the tool itself were collected. 

6. A meeting decided what changes or improvements were required. 

7. Improvements were rolled out. 

8. A requirements list for Issue Consultation was issued to remaining Cities 

9. Traffweb Issue Consultation was rolled out to all Cities. 

 
B LineMap Design Consultation: 
 

1. A single City was selected as the pilot for Design Consultation to test LineMap 

and Traffweb. 

2. Design Options were created by City Designers, supported by Buchanan 

Computing. 

3. Any initial issues or were fed back to Buchanan’s and rectified ASAP. 

4. Local Workshops were conducted to test the digitisation of Road Space blocks. 

5. Final issues were resolved. 

6. Designs were published to Traffweb for a Design Consultation over a fixed 

period.  

7. Stakeholder comments concerning the tool itself were collected. 

8. A meeting decided what changes or improvements were required. 

9. Improvements were rolled out. 

10. A Final Requirements list for Design Consultation was issued to the remaining 

Cities 

11. LineMap was rolled out to all Cities. 

12. All systems went live and were maintained under support 

13. Any training required was conducted remotely for each city 

 
Any issues, improvements or enhancements required beyond this point were dealt with via technical 
support and a series of meetings where partner cities suggested a list of enhancements. 
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5.  Tool refinement 

This section looks at how the software tools were improved based on feedback from the five partner 

cities regarding the stakeholder engagement experience. 

Traffweb 

The following list of enhancements and improvements were made to Traffweb for issue and design 

consultation: 

1. Base maps were updated where improved mapping was available as some stakeholders 

found locating themselves on the map and relating this to their surroundings difficult. 

OpenStreetMap was used where mapping from the cities could not be easily sourced as it 

displayed features such as cafes and restaurants: 

 

Additional details were added such as the station symbol to aid users in locating landmarks: 

 
 

2. When conducting surveys in Traffweb, on completion of the survey Traffweb would display a 

map of all recorded issues within the study area. It was noted that for on street surveys this 

led to an increased number of steps to reset the survey for the next participant. The step of 

displaying issue results was removed from the process.  
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3. Cities found dashboard reporting very helpful but wanted to be able to download the charts 

and graphs as a report. A Chart report was added to the dashboard: 

 

Clicking on the button highlighted above will download a pdf report of all charts on the current tab: 
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4. Some users reported it could be difficult to start the engagement process from the landing 

page. If the introductory text was too long, the ‘Begin’ button could be scrolled off screen. 

This varied from city to city and the type of device used. The page was redesigned to ensure 

the ‘Begin’ button was displayed on the page at all times. 

 

 
 

5. For Design Consultation Traffweb was enhanced to include a design survey to better capture 

the feedback of users. 

LineMap 

1. Following user feedback, one of the biggest issues was the need to alter the base maps for 

some designs. 

a. Within LineMap, base maps are usually fixed and only change when the national 

mapping agency supplies an update.  

b. It was apparent there was a need to alter the base maps on a per design basis, for 

example to build out kerbs or replace footways with traffic lanes. 

c. Buchanan Computing introduced the concept of surfaces, where features were 

introduced and matched with the styling of the kerb and road from the base 

mapping – e.g. tarmac, footway etc. These features could then be drawn into a 

design as a new base map feature and road markings could be applied on top: 

This section remains 

fixed at the foot of the 

page so the ‘Begin’ 

button remains visible 
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Base Maps where the footway and traffic lane 

needs modifying for a particular design 

Surfaces widen the footway on the right and 

straighten the traffic lane using surface 

features 

d. Surfaces were associated with an individual design and so new designs could be 

created with the unaltered base maps.  

 

2. One of the biggest ‘enhancements’ was to the workflow of creating LineMap designs. Mid-

project feedback suggested that having the existing situation road markings as a starting 

point for creating new designs sped up the design creation process. LineMap users were 

advised to start the design process by creating a ‘Current Situation’ design 

3. Other improvements based on City feedback included the ability to drag a block or marking 

and its construction line to a new location rather than having to redraw the feature, and the 

ability to click and delete a feature rather than having to select for deletion by drawing 

round the object. 
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6. Exploitation of tools 

It is the intention of MORE that all tools developed will be used to benefit other projects.  In the case 
of the consultation and engagement tools, there is a wide variety of possible uses, both transport 
related and more generally for local and regional government. 
 
LineMap is limited to uses relating to roads and transport corridors, so will be promoted principally 
to highways authorities.  Traffweb has a much wider potential for almost any type of public 
information provision, optionally involving the gathering of feedback or of formal consultation. 
 
Examples of its potential uses include: 
 

• Consultation of urban design and streetscape generally 

• Consultation on proposals affecting traffic flow 

• Consultation on current parking and servicing and proposals for change 

• Planning and land use issues and proposals 

• Retail surveys 

• Proposed cycle measures 

• Public safety, security and crime reporting 

• Highway safety and the notification and recording of collisions or other traffic incidents 

• Noise, air quality and other environmental issues 

• Current public transport provision, proposals for improvement and the locations of stops 

• Severance issues 

• Planning and land use proposals 

• Questions and suggestions relating to landscaping and horticulture 

• Locations of numerous possible amenities, such as seats, litter and recycling bins, cycle racks 

• Issues connected with signing and way-marking 

• Accessibility for people with disabilities 

• Fault and highway defect reporting 

 
Buchanan Computing will work initially with the experts from the city authorities already involved in 
MORE. They are best placed to decide whether to continue using the tools within their field of 
transport and highway planning. We expect them to be able to recommend other contacts within 
their authorities and elsewhere within their countries, who might have need for this same 
technology.  We will seek to partner with those authorities, or with local agencies they have 
experience with for promotion of the tools within their country.  It is our experience that an agent 
based in the country concerned is almost always necessary for successful sale and support of 
software. 
 
Every opportunity will be taken to promote the use of these tools, and the results of MORE generally 
in relevant specialist media, at conferences and with professional bodies. 
 
A demonstration website has been set-up, and potential users of the software will be directed to 
this.  Translated versions will be made available for countries where the interest is sufficient. 
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APPENDIX A: TRAFFWEB STAKEHOLDER TOOL 
GUIDE 
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INTRODUCTION 

Overview 
 
The Traffweb Stakeholder Tool is a web application developed under the MORE project (Multi Modal 
Optimization of Road Space in Europe) which is a European Commission funded research project that 
recognizes roads that are under pressure and the demand for transport is becoming increasingly 
diverse. Delays and variable travel times put the reliability of the network at risk both for passengers 
and freight. This requires a more efficient use of road space, applying multimodal design. 
 

(For more information about the MORE Project: https://www.roadspace.eu/) 

 

 
 
MORE will implement and test tools for roadspace design in five urban nodes of the Trans European 
Transport Network (TEN-T): Budapest, Constanta, Lisbon, London, and Malmö. 
 
In order to help the project achieve the objectives for each of the five cities the Traffweb Stakeholder 
Tool will consists of two types of consultation: 
 
• Issue Consultation: Collect issues, suggestions and comments regarding the current situation within 
the study area; 
• Design Consultation: Feedback on design(s) for the improvement of the study area. 
 
That means that in the website you will be able to: 
 

1. Collect data from stakeholders relating to issues and feedback during Issue Consultation. 
2. Collect data from stakeholders relating to designs and feedback during Design Consultation. 
3. Provide feedback on stakeholder engagement via a secure interactive dashboard and 

downloadable reports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.roadspace.eu/
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TRAFFWEB USE CASE 

 
This diagram shows what each kind of user can do in the website 
 

Anonymous

Create a 
located/general 

comment

Professional

Generate 
Reports and 

check the 
feedback

Documents 
Consultation

Designer

Generate 
Reports and 

check the 
feedback

Documents 
Management

Users 
Management

Schemes 
Management



   
 

©2019 Buchanan Computing  0   TRAFFWEB STAKEHOLDER TOOL GUIDE 

 

CHAPTER 1: GENERAL WEBSITE NAVIGATION 

 

1.1 General Navigation 

 
The first thing to do is launch your favourite browser and open the city landing page at:  
 
Budapest - https://www.moreconsultation.eu/budapest 
 
Constanta - https://www.moreconsultation.eu/constanta 
 
Lisbon - https://www.moreconsultation.eu/lisbon 
 
London - https://www.moreconsultation.eu/london 
 
Malmo - https://www.moreconsultation.eu/malmo 
 
 
On each city landing page you will have a short description and two buttons. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The begin button (blue arrow) will redirect you to the consultation page (see here) that you will see 
later. 

https://www.moreconsultation.eu/budapest
https://www.moreconsultation.eu/constanta
https://www.moreconsultation.eu/lisbon
https://www.moreconsultation.eu/london
https://www.moreconsultation.eu/malmo
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The   button (red arrow) is the most import button when we speak about navigation. 
 
If you press it when logged out you should see this: 

 
 
 
Here you can: 
 
- Login; 
- Create a new account; 
- Reset your password. 
 
 
If you are logged in you should see this: 

 
 
 
And you will be able to: 
 
- Logout; 
- Edit/Delete user; 
- Go to Home; 
- Go to Dashboard Page;  
- Go to Administration Page. 
 

1.2 Create New Account 

 

In order to create a new account you should press  and then  
 
 
You will get the register form that you need to 
fill with a valid email address (you will have to 
validate it). 
 
Select the city you are working with and press 
“Register”. 
 
After that you will receive an email with a 
validation link that you need to follow in order 
to validate your account. 
 
Your account is now created, however in order 
to you to have access to the Dashboard one of 
the designers from your city need to accept 
you as a Professional user. 
 
 
 
Note: To create a designer account you have to follow the same steps and then contact Buchanan 
Computing at tech.info@buchanancomputing.co.uk in order to promote your user. 
 

mailto:tech.info@buchanancomputing.co.uk
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1.3 Reset Password 

 

To reset you password in case you forgot it press  and then  
 

 
 
Simple form will appear, and you just need to insert your username and press “Send Password Link”. 
 
A few moments later you should receive an email with further instruction. 
 
Note: If you don’t receive any email (make sure that is not in your spam folder) or you don’t 
remember your username please contact Buchanan Computing at 
tech.info@buchanancomputing.co.uk. 
 

1.4 Edit Delete User 

 

Now that you have an account you can press  enter your username and password in order to 
login. 

Once logged in if you press again  as previously shown you will get this window: 
 
 

   
 
 
 
 
 
 
 

As you can see in the image below, you cannot change your email address, however in order to 
update any of the other details, just change them and then press “Save Changes”. 
 

 
 
To delete your user you have to press “Delete User”, and type your password in order to confirm 
that you really want to delete your user. 
 
Last option in this page is the ability to change your password pressing the “Change Password” link 
and you will receive an email with further instruction.  

If you click in your name it will 

redirect you to the user details 

page where you can edit some of 

your details, delete your user or 

reset your password. 

mailto:tech.info@buchanancomputing.co.uk
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CHAPTER 2: CONSULTATION PAGE 

To open the consultation page you need to press the  button and then in the navigation windows 
press “Home”. 
 

Once in the city landing page you should press the “Begin” button. 

 
 
After that you are in the consultation page. In this page anyone can insert new comments regarding 
Schemes or Designs under consultation. 
 

2.1 Tool bar 

 

  

Hide / Display Tool Bar 

Zoom in and out 

List all the Schemes and streets within the 

Scheme 

Insert a comment in a specific 

place 

Insert a general comment (no location). 

Legend of items displayed in the 

map 
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2.2 Insert a new comment 

 
In order to insert a new comment for issue consultation you need to open the Tool Bar as shown 
previously and then depending on which kind of comment you want to insert you should: 
 

• Specific location comment - >     ->  Then you click in the location where you want the 
comment in the map 

 

• General comment ->   
 
Note: In the Tool Bar you have the list of streets within a Scheme, is you click in one of the streets it 
will move the Map to that street. 
  
After that you will get a form to fill with the comment details:  type of issue, issue time of the day 
and finally your free text comment.  
 

 
 
 
Once finished press “Add” and you will have two options: 
 

 
 
If you press “Make another comment” you have to follow the same steps, and if you press “Finish” 
you go to the next form which is the user details. 
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You fill the form, press “Submit” and it’s done. 
 
At this point you will be able to see other people comments and you can click on the in order to 
check the type of issue, issue time of the day and the date that it was inserted. 
 

 
 

2.3 Complete a Design Survey 

 

In order to provide feedback on designs created using LineMap a survey is available to complete on 

individual designs. You can view designs using the highlighted area below, simply by clicking on the 

design name: 
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In the figure above clicking on ‘Empire Heights Blocks’ will navigate the map to the designs extents 

and display the design elements on the map. You can click on a street name to relocate the map 

further, or the  button to view a summary of the design: 

 

There can be two representations of a design, blocks as shown above or the corresponding road 

markings: 
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To complete a survey on the design click first on the design (1) then the survey button (2): 

 

Complete the questions on each page as displayed. A progress bar tracks the percentage completion 

of the survey at the top of the dialog: 

 

1 

2 
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Click Next to proceed to the next page of the survey. Any errors will be flagged in red text for you to 

correct before proceeding. ‘Back’ will return you to the previous page and ‘Cancel’ will close the 

survey without completion. 

On the final page of the survey ‘Next’ will be replace with a ‘Submit’ button: 

 

 

Click on ‘Submit’ to complete and save the survey. 
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CHAPTER 3: DASHBOARD PAGE 

 
In the “Dashboard” page you can do a few things such as: data analysis from multiple charts, print 
reports and download documents. 
 

To open the Dashboard you should press  and then  
 

 
 
 

3.1 Download Documents 

 
In the “All Documents” list you will have one button per Scheme, if you press it you will have a list of 
all documents attached to that Scheme. 
 
Note: If the list is empty that means that no documents were uploaded yet (Upload Documents). 
 
 

3.2 Download Report 

 
To download a report you should press the “Download Report” button. As soon as the report is ready 

for download you will have a new button to download it. 
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3.3 Comments Time-Line 

 
In the left Schemes Bar you can filter the data for each Scheme. 
 

 
 
When you select a single Scheme you will be able to “navigate” in time to see how many comments 
you had in a time-line. 
 

 
 
Pressing the arrow’s you can go back and forward in time. 
 
Note: When all the Schemes are selected in the Schemes bar, you will get a static generic time chart 
by Month. 
 

3.4 Charts 

 
The two upper charts will display data related to the responders, the most frequent mode of 
transportation, and their interest in a particular Scheme. 
 
Note: A responder can have more than one mode of transportation and more than one interest. 
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The two bottom charts will tell you which is the most frequent type of issue, and at what time is that 
issue happening.  
 

 
 
 

3.5 Map 

 
Apart from this charts you can also check in a map where and which kind of issue are being reported. 
At the top of the page press “Map”. 
 

  
 
In this page, you will have a legend and you can turn items on and off clicking in the check box. 
You can also switch between types of issue, and time of the day. 
 
All the comments are clickable and they will prompt with a Popup displaying data related to the 
response that you clicked at. 
 
The pie chart will show you the amount of located vs general comments. 
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3.6 Chart Report 

 
You can download or print a report containing the charts: 
 

 
 
Clicking on the ‘Chart Report’ button will produce a preview of the report, which you can then either 
print or download as a pdf file. 
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CHAPTER 4: ADMIN PAGE 

 

To navigate to the “Admin” page press  and then “Admin”: 
 
 
 
 
 
 
The Admin page is only accessible by “Designers”, and here you will be able to: 
 
• Update Scheme’s dates and set them as visible or not 
• Accept or Decline new users 
• Delete existing users 
• Upload, view and delete documents 
 
 

 
 
 

4.1 Scheme Management 

 
If you want a scheme to be visible to consultation you must set it as visible, and the consultation 
dates must include the current date between them. 
 

 
 
Note: Only one Scheme can be updated at a time, which means that if you change two of them and 
save one, the changes made in the second one will be lost. 
 

4.2 User Management 

 
The User Management area has two lists: 
 

• Users Request – If someone create a new account and validate it, where is where you can 
accept or reject them. 

• Confirmed users – List all users registered in the system and allow you to delete them. 
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4.3 Document Management 

 
All the document in this tool are “attached” to a Scheme. 
 
In order to upload a new document to the application you have to choose the Scheme you want 
from the Scheme drop down list and the click in the “Browse” button to select a file from your 
computer. 
Finally click in the “Upload” button. 
 
In the Scheme’s Documents you have a button for each scheme available in the system, and if you 
press one of them you will be able to see all the documents attached to that scheme. 
If you press the Document name you will be able to download it, and if you press the “Delete” 
button you can delete it. 
 
 

USEFUL CONTACTS: BUCHANAN COMPUTING 

 

• Support 
 
If you have any problems, issues or queries with regards to using the system please feel free 
to contact our support helpdesk: 

• Tel – 020 8846 3220 

• Email – support@BuchananComputing.co.uk 

mailto:support@BuchananComputing.co.uk


   
 

227 Shepherds Bush Road, London, W6 7AS 
020 8846 3220    training@buchanancomputing.co.uk     
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INTRODUCTION 
 
Overview 
 
LineMap combines the power of CAD with the simplicity of word processing, to provide a fast and 
accurate design tool  
 
This edition of LineMap has been designed for the MORE project to aid collaborative design and 
stakeholder engagement, focusing on road space use design using blocks as well as road markings 
which can be published to Traffweb for consultation. 
 
(For more information about the MORE Project: https://www.roadspace.eu/) 
 

 
 

LineMap: Comprehensive tool for drawing and designing road markings.  It contains all the latest 
TSRGD road markings (lines, text and arrows/symbols), as well as the Pedestrian Crossing 
Regulations. It can be used to generate a basic authority wide record of all your road markings.  
Other features include:  
 

• Create and manage Schemes and Designs  

• Produce high quality scale drawings  

• Range of drawing tools  

• Export and import facilities to both CAD and GIS packages 

• Publish designs online using Traffweb 
 
This training guide covers the core aspects relating to the design of road markings, as well as 
exporting and publishing data as required by the MORE project. 

•  

https://www.roadspace.eu/
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How to use this Guide 
 

The structure of the training document is designed to take users through different work flows and 
tasks, rather than just by each function. 
 
Where a series of commands is used with the > symbol this means a series of commands from the 
dropdown list at the top of the screen. Other ways are by using icons. 
 

 
 

 

‘Single quotes’ denote text taken directly from LineMap headings from menu and display boxes. 
 

Home > Security 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

©2020 Buchanan Computing  4           LineMap – MORE Edition 

GLOSSARY OF TERMS 
 
 
Annotation Any additional information that is related to the design of a scheme 

but not specifically a marking can be stored as annotation e.g. 
changes to kerb layouts etc. 
 

Base Mapping The Ordnance Survey maps that act as a base, either Master Map or 
Landline data.  The maps of the relevant region are held within the 
system as a series of layers that are non-editable, on top of which 
schemes of markings are added. 
 

Diagram / TSRGD No. This is the reference number for a type of road marking that is 
referenced by The Traffic Signs Regulations and General Directions 
Manual of 2002. 
 

GIS Geographical Information System. An organised collection of 
computer hardware, software and geographic data designed to 
efficiently capture, store, update, manipulate, analyse, and display all 
forms of geographically referenced information. 
 

Guideline or Construction 
Line 

The temporary lines that are used to plot the resulting marking.  They 
are plotted either manually or with system assistance, i.e. to follow 
the kerb line and are depicted as blue pecked lines.  They are only 
present whilst the marking is being plotted. 
 

Scheme A scheme defines an area of study in LineMap and is defined either by 
a simple rectangle showing its extents, or by the extents of the 
designs within the scheme. Each scheme has a date advertised and 
date closed to denote its consultation period. 
 

Design Groupings of markings can be placed together into a design.  These 
will generally be markings that are designed together and plotted at 
the same time.  They may cover an area such as the re-design of a 
road junction or a broader area such as the length of a highway. 
 

Template line This is the saved version of the guideline that depicts the 
extent/direction of a marking, and it is from this that the marking 
could be regenerated; these are depicted as red pecked lines. 
 

TSRGD Traffic Signs Regulations and General Directions 
 
Traffweb 

 
Online Consultation and stakeholder engagement tool 

 
Issue Consultation 

 
Collect issues, suggestions and comments regarding the current 
situation within the study area 
 

 
Design Consultation 

 
Feedback on design(s) for the improvement of the study area 
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1.1 Fundamentals 

 
1.1.1 Starting/Exiting a LineMap Session 
 
You will first need to log onto your cloud service at the following web address:  
 

https://buchanancloud.net 
 

 
 
Once logged in, you will be able to click on the LineMap icon to launch the application: 

 
 
Explorer will give you access to a drive where any LineMap related documents should be saved. 
 
To finish your LineMap session click on the LineMap tab and select exit (Alt + F4) or just use the cross on 
the top right corner of your screen. 
 
1.1.2 LineMap tab menu 
 
The following tab will be displayed on start-up: 
 

 

You can hide the tabs by clicking on the  button on the bottom right corner of the tab’s ribbon and you 
can bring all the tabs back on display by simply double clicking on the text (e.g. HOME, VIEW) at the top of 

your screen. The icons with an arrow pointing down  below a button in the ribbon bar means that more 
options are available for you to choose from.  
 
 

 

 

https://buchanancloud.co.uk/
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The buttons displayed on the tabs vary in size depending on your screen resolution or on how 
maximised/minimised the LineMap screen is. Buttons may also be grouped together if your screen 
resolution is too small. 
 

1.1.3 Right click menu 
 
Most of the fundamental functions covered in this chapter are accessible via the tabs but also via a simple 
right click on the map display. The right click menu allow a quick access to the most commonly used 
LineMap functions such as zooming, panning, street search, selecting or querying information.  
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

Zooming tools 
 
Panning tool 
 
Street search 
 
Selecting tools 
 
Querying information 
 
Reporting 
 
Labelling tools 
 
Street View link 

Right click menu option (view only mode) 
 

 
1.1.4 Zooming Options 
 
You can zoom in and out of your map display using the LineMap zoom features from the HOME > View or 
by right clicking on the map.   
 

The   button can be used to zoom in and the   button can be used to zoom out. Simply select one of 
the zoom features and click on the map display. Alternatively, you can use the scroll button on your mouse.  
Scroll up to zoom in and scroll down to zoom out.  

A more precise way of zooming in is to select the  button and click and hold to create a box around the 
specified area you want to zoom in to.  The map display will zoom directly into the chosen area, avoiding 
the need to repeatedly click or scroll.  
 
There is also the option to define a particular zoom or scale via the Change View facility.  This can be 

accessed by clicking on the Change View button  or by right clicking on the display and selecting the 
Change View option from the pop-up menu.  The following dialogue will be displayed: 
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The cartographic scale will allow you to select a 
specific scale for your display which then can be 
used for printing maps out. 

 
 
1.1.5 Repositioning the Display 

You are able to pan around your map display using the Grabber tool  also available where the zooming 
buttons are (HOME > View).  Having selected this, simply click and drag the map around to the required 
location. You can also click in the scroll wheel (without rotate) and move the mouse in the map window. 
 

 
 
1.1.6 Using the Gazetteers 
 
It is possible to relocate your map display to certain streets or buildings by making use of any available 
gazetteers.  All LineMap’s gazetteers can be found under the tab HOME > Find. Several gazetteers are 
available for you to use. 
 
The National Land and Property Gazetteer (NLPG) or Address Search (OS AddressBase) should be used 
whenever possible as these contain the most data allowing you to narrow down your searches. 
 

  

Address Gazetteer NLPG Gazetteer 

 
Here you can type in the required street name (in full or in part) as well as any other information that may 
be used to narrow down the search (e.g. ‘Town’ can be used to differentiate between two streets of the 
same name within different towns).  You can then click Find.  A list of possible matches will be displayed 
allowing you to select the relevant area: 
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Clicking Find will relocate your map display to the selected street or Apply to zoom to the street highlighted 
in blue without closing the dialogue. 
 

 

A list of possible locations will only be displayed if your search criterion matches several records.  If 
your search only produces only one record LineMap will automatically relocate to the street found. 

 
You can also easily access the AddressBase gazetteer by right clicking anywhere on the map and selecting 
the Find option from the list as shown below: 
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1.2 Designs, Schemes, Routes to display 

 
1.2.1 Designs to display 
 
All markings and surfaces are allocated to a ‘Design’. Designs can be grouped together as a ‘Scheme’. By 
Default no designs are displayed.  
 
HOME>Designs or SCHEMES>Select Designs or right click on the mapping on select ‘Alter Display’: 
 

 

Select the relevant design from proposed designs, then click 
add. Click OK to add the design to the map display 
 

 
1.2.1 Schemes to display 
 
To display all schemes as extents chose: SCHEMES>View. This shows all scheme extents. To view on the 
map right click and choose View Entire Layer, then choose the layer ‘LMSchemes’ from the list. 
 

 
 
The button is highlighted to show the Schemes view is displayed. Click View again to hide the Schemes layer 
from the map display. 
 
1.2.1 Routes to display 
 
To display all Routes: SCHEMES>View in the Routes section.  
 

 
 
To view on the map right click and choose View Entire Layer, then choose the layer ‘LMRoutes’ from the 
list. 
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1.2.2 View the most recent added design 
 
To view the most recent design right click on the map and select from the menu View>Locate Most 
Recently added.  
 
1.2.3 View all displayed designs 
 
To view the most recent design right click on the map and select from the menu View>View Entire Layer 
and choose Markings – Design…. 

 
1.2.3 The ‘information’ button 
 

 
 
Click on the information button to access information from the LineMap database. Either right click on the 
map and access the button from the toolbar or HOME > info 
 
Once this button has been pressed, click on any input item on the map in order to view information about 
it. 
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1.3 Labels, maps & reports 

 
1.3.1 Labelling 
 
LineMap allows you to label or display saved labels for markings on the map display (via HOME > Labels). 
You can change the LM labels style under ADMIN > Settings > LineMap > Label Style. 
 
1.3.2 Generate Labels 
 

 

You can label items on display by clicking on the Generate labels tool. Once the labels 
generated the Label Tab will appear: 

 
 
From the Add Label button, click on a LineMap feature to display the label on the map. You will need to 
click on each individual items you wish to label.  
 

 

Reposition them using  and dragging them to the required position.  Individual labels styles can be 
edited (text and appearance) by double clicking on them and deleted by using the Delete key on your 

keyboard. Once you are finished positioning labels click  to return to the main ribbon. 

 
1.3.3 View Saved Labels 
 

Use the  button on the HOME tab to toggle saved labels on and off. 
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1.3.4 Items selection 
 
Item Selection is on the HOME tab and right click menu. 
 

 

Selection tools 

To select one item, use the  tool. The item you wish to select will be highlighted as soon as you click on it. 
 

 
 
Note that the ‘highlighting style’ may vary according to your system setup.  
 
To select more than one item, hold down the <Ctrl> key and select additional items one by one. 

Alternatively, to select multiple items over a wide area, draw a polygon with your polygon select tool  to 
define your area of interest. 
 

 

→ 

 
Drawing a polygon 
using the polygon select tool 

 Selected markings are highlighted 

 
To select items within a region use region select  and ensure the region is displayed on the map   
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1.4 Formal Printouts 

 
1.4.1 Print Preview Options 
 
Several print options are available via HOME > Print Preview.  The following options will be displayed: 
 

 
 
You will be able to enter a title for your printout in the field at the very top of the dialogue.  
 
The Printing Source section allows you to select a scale and template.  The scale will always be populated 
with the default scale value as set within your system settings. This can be overwritten and changed as 
required.  The template drop-down list can be used to select the size and layout of your printout.  
Templates are available for both portrait and landscape printouts ranging from A4 through to A0. 
 

 

The Additional Text section allows you to enter additional information to be included on your 
printout.  Specific fields for a drawing number and author are provided, as well as four 
additional text fields for any extra information you wish to add. 

 
The ‘Include’ section allows you to select additional extras.  You can choose to include a legend window, a 
north point, a watermark, location map, and summary sheet. 
 
Once your options have been specified click on the Preview button to generate your printout. 
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If you chose to include a north point, location map, or legend window, these can all be moved as required 
by clicking and dragging them.  Similarly, any other text fields on the print preview can be moved in the 
same fashion. 
 
1.4.2 Print Preview Toolbar 
 
The toolbar at the top of the Print Preview screen includes all the MapInfo drawing tools so you can add 
any polygons, lines, or symbols at this stage if required. 
 

 

The style button will allow you to setup how the polygons / lines / symbols will look like before 
you plot them. 

 

The draw button will allow you to plot either a polygon or a line or a symbol on the preview. 

Note that the   button will allow you to add additional text to your printout if required. 

 
More options are available to you to improve or save your map print out:  
 

 

The pan tools allow you to slightly move your print preview in the direction 
of the arrows on the toolbar. 

  

 

Alternatively, you can use the grabber to move the print preview instead of 
the pan tool arrows. 

  

 

If you still cannot see all the information you need on your print preview, 
you can change the scale to a bigger one which will effectively zoom out 
and show more of your mapping.  For clarity purposes you might also want 
to use the layer control button to change or hide certain unnecessary layers 
that clutter your display.  

  

 

If you move and resize your legend box, you might notice that the text in 
the legend is truncated.  To fix this, use the legend tool to zoom in and out 
of the legend box. 
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Any labels that was previously saved can be displayed to add further 
information to your print preview. 

  

 

Once you’ve finalised your map, you can either print it, save it as a PDF 
booklet or export it as a picture format (JPEG, GIF, PNG etc.). 

  

 
Use the white arrow to return to your LineMap session. 

  

 
1.4.3 The View Frame Option 
 
Within the Print preview dialogue above, you can choose to View Frame rather than go directly to Preview.  
Using the View Frame option you will be able to see what will be included within the bounds of your print 
preview.  Having clicked on the View Frame button the following screen will be displayed: 
 

  
 
The red rectangle denotes what will be included within your print preview.  You can move this by clicking 
and dragging it.  Note that in resizing your print frame the scale of your print preview will also be altered. 
You can choose to rotate your print frame so that your print preview will be rotated using the Rotate Print 

Frame button . 
 

 

You can manually enter an angle of rotation, or you can choose from 

a drop-down list using the  button.   
 
Once you’re happy with your print frame click on the Print Preview 

button  to continue to generate the print preview. 
 

 
1.4.4 Printing Several Print Frames 
 
LineMap allows you to generate a print preview of several print frames. Select the View Frame button from 
the print preview dialogue. The print frames will then appear. 
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Select the extra print frame  button to create additional printout in the preview.  Each print frame 
works independently thus can be individually rotated and moved without impacting on the other frames.  
 

 
 

The print preview can be generated using the  button.  You will then be able to scroll through the pages 

or jump to each print frame’s print preview using the  buttons at the top of the screen.  If you 
chose to include a summary sheet, this will appear as the last page of your print previews, displaying an 
overview of the area that your print frames include. 
 

 
 

To create a PDF booklet with all your printouts click on the  button and select the directory where you 
wish to save them: 
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Make sure that you click on the All button should you wish to save all your printouts and not just the one 
on display. 
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1.5 MORE Project Quick Start Guide 

 
This section is intended as a quick start guide for the use of LineMap in the MORE project. It summarises 
the main tasks required to create designs, publish them to Traffweb and produce project reports. The main 
tasks are: 
 

• Design Creation using Road Blocks and/or markings 

• Traffweb Publishing for Design Consultation 

• Export Road Markings to VISSIM 

• MORE Project reporting 
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When creating a design, this can be represented as road use blocks, markings or both blocks and markings. 
It is recommended that you keep blocks and markings as separate designs, so if you intend to use both for 
consultation you will need to create 2 designs, one for each representation. 
 
The diagram below summarises the steps you need to take to create a LineMap design for the MORE 

project: 

 

 

1. Create New Design 

2. Create Design 

for Blocks 

Blocks or 

Markings? 

3. Draw in Blocks 

and/ or Markings 

4. Export Markings 

to VISSIM 

5. Complete VISSIM 

Summary 

6. Publish Designs 

to Traffweb for 

Consultation 

2. Create Design 

for Markings 

Blocks only Markings 
only 

Blocks and 
Markings 

7. Reporting 
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1.5.1 Design Creation 
 
Step 1: Create a new Design 
 
To start the process of creating a new design you need to be in edit mode so click on the  

HOME > Security padlock icon:   
 
Enter the edit password (this is blank by default) and the padlock icon will change to an open lock see 2.1.1 
Entering Edit Mode. The schemes dialog will then appear. Each design belongs to a particular scheme. So 
first select the scheme: 

 
 

Next click Create under Assigned Designs to display the New Design dialog: 
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Step 2: Create Design for Blocks 

 

 
 

a) Enter a Design Name based on the study area and section and add the word ‘Blocks’ at the end of the 
name 

b) Enter todays date as the Design Date 
c) Using the MORE UID Spreadsheet (MORE_UniqueIDGenerator.xlsx), generate your unique identifier 

reference number for your design by choosing the relevant options:  
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d) This will generate a unique design ID highlighted above. Copy and paste this into the field SEE_Out1 
Unique Identifier Reference. 

e) Check any relevant Design Options for the fields SEE_out5 to SEE_out8. 
f) Click OK to save the design. 
 
Step 2: Create Design for Markings 
 
If you are going to produce Road Markings for your design: 
   
a) Enter the Design Name with the word ‘Markings’ at the end. 
b) Enter the same information for steps (b) to (f) from the design for blocks 
 
Having two separate designs for Blocks and Markings will make it easier to create designs quickly and allow 
stakeholders to switch between the two views in Traffweb. 
 
Step 3: Draw in Blocks or Markings 
 
a) To draw in Blocks make sure you are editing the correct design. The quick way to do this is to right click 

on the map and choose Update Design: 
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Choose the design and click update to begin: 
 

 
 
b) To draw the Road Use blocks, see 2.2.4.2 Diagrammatic markings 
 

i. Choose your Road Blocks design for Update. 
ii. Position the map display in the area you want to create the road use block 

iii. From the explorer window select the type of block you want to create: 
 

 
 

iv. To follow a kerb line, use the  tool on the Designs Tab to plot the start and end points, 
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then click to create the guide line: 

 
 
 

v. If there is no kerb line you can draw the guideline using the tool. 

vi. Once the guide line is displayed as above, click on plot to generate the block: 
 

 
vii. If the block plots on the wrong side of the kerb, right click on the map and choose the 

select  tool. Click on the block to highlight it then click  to replot the block. 
 
c) To create Road markings you can either draw these directly into the Road markings (see 2.2 Using the 

guidelines to draw markings) design or generate them from Road Use Blocks. To generate markings 
from Road Use Blocks: 
viii. Choose your Road Blocks design for Update and view entire layer. 

ix. Using the select arrow (right click on the map and choose ) 
x. Highlight the Blocks you want to convert to markings. Hold shift to select multiple blocks: 
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xi. Then click on DESIGNS > Convert to Diagrammatic:  
 

 

 
 

xii. Choose the Design your ‘Markings’ design and click OK 
 
If you select multiple markings to convert you may be asked to choose parameters for each marking type. 
Enter any parameters and your markings will be generated, see 2.2.4.2 Diagrammatic markings for further 
information. 
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Step 4: Export to VISSIM 
 
To export your markings to VISSIM see 3.1.3 VISSIM Export 
 
Step 5: VISSIM Summary 
 
Once you have modelled your design in VISSIM you need to summarise the model. Go to SCHEMES > 
Maintenance. Select the relevant design and click Details: 

 

 
 
Enter the summary text in the box highlighted above and click OK. It is recommended you do this before 
publishing the design to Traffweb. 
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Step 6: Publish Designs to Traffweb for Consultation 
 
To publish your designs to Traffweb, click on the Admin Panel on the Ribbon and Choose Traffweb under 
the export section: 

 

 
A dialog will appear giving you the option to publish for Issue Consultation or Design Consultation. Choose 
Design consultation, then click OK: 

 

 
 

Your designs will be sent to the Traffweb server. Traffweb checks every 2 hours for new designs so there 
may be a delay before your latest designs are made live. 
 
 
1.5.2 MORE Project Reporting 
 
For Step 7 in the process you will need to generate specific reports on each design. LineMap reports have 

been formatted to ensure that they comply with the MORE project ‘Instructions for Data Provision’ 

document. For each design in LineMap you will need to create: 

• A printed report summarising the road use blocks or markings 

• A Design Plan 

Design Plan 

a) To print the design you must first select it for update:  

i. Right click on the map: 
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ii. Then select the design you want to print: 

 

 

iii. Right-click on the map and choose ‘View Entire Layer’ 

iv. Select the design from the list (it should appear near the top) and click OK to centre 

the map on the design. 

v. Next choose HOME> Print Preview.  

vi. Choose either Portrait or Landscape to suit the Design and click OK to generate the 

print. 

vii. The Design Name and ID will appear on the print. 

viii. Finally Save the print as a PDF file by clicking on the  button. 

 

Printed Report 

a) Click on the REPORTS Tab then click ‘Single Design’ 

  

b) Then simply select the design from the list and click OK: 
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c) A document ‘MORE_LMReport’ will be produced. Choose FILE> Save as to save the report in 
the required format. By default the report will be produced in Open Document Format (ODT) 
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2.1 Overview of the basics 

 
2.1.1 Entering Edit Mode 
 
In order to add or amened data in LineMap, you must enter the edit or supervisor mode.  This can be done 

by selecting the padlock button , where you will be prompted for a password.  Enter your Edit mode 

password and click OK to continue.  The padlock will unlock to indicate you are in the correct mode .  
 
2.1.2 Summary of Processes 
 
In order to create new markings within LineMap the processes required are summarised below:  
 

1. Create new scheme/or select existing scheme for update (Chapter 1) 
2. Locate the area of street required by moving around the map (Chapter 1) 
3. Select Diagram number for marking to plot 
4. Allocate dimensions/text for required marking 
5. Generate guideline (Chapter 1) 
6. Select the guideline/s (Chapter 1) 
7. Plot the marking 

 
2.1.3 Creating a scheme 
 
Before you can start entering new markings in LineMap, you will need to create or use an existing scheme. 
Schemes can be made of many marking designs or can be created specifically for one design. In terms of 
hierarchy within your system, it follows the following structure: 

 
 
Once you enter edit mode the following dialogue will appear: 
 

Design

Marking
Block Surface

Scheme
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You can also show this dialogue using the tab HOME > Schemes 
You can manage (create, delete or see more details) all schemes in your system from this dialogue. To 
create a new scheme just click on the Create button. You will then switch to the map display and be 
prompted to draw a scheme rectangle. This defines the extent of the scheme for Issue Consultation.  
 
Click and drag holding the left mouse button to create a scheme area. Release the mouse button when 
finished and the following dialogue will display: 
 

 
 
Enter a scheme name and alter the advertised and closed dates if required (this can be done later). Click OK 
to create the scheme and it will be displayed on the map. 
 

 

Note that you cannot delete a scheme that contains designs 

 
2.1.4 Managing designs within a scheme 
 
Each design created in LineMap will have to be part of a scheme. Should you have more than one scheme 
setup, you can transfer or move designs from one scheme to another. Alternatively you can delete a design 
or check its details by clicking on the Delete or Details button in the Assigned Designs part of the dialogue: 
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2.1.5 Create a new design 
 
Within the Maintain scheme dialogue, select the scheme you wish to work with and then click on Create in 
the Assigned Designs part of the dialogue: 
 

 
 
You will then be asked to provide further information about your Design: 
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Enter a short description in the first field. This is often 
the TRO reference number.  This field is the only 
compulsory field within the dialogue. 
 

Enter a design date using the  button. 
 
 

2.1.6 Selecting Designs for Update 
 
You can select a design for update by selecting it from the Maintain Schemes dialogue and then click on 
Update or via the tabs DESIGNS > Update.  
 

 
 
Select a design from the list, click OK to continue.  Make sure you are working on the selected design by 
checking the bar at the top of the map: 
 

 
 
 
Alternatively, you can right click on the map and click on the Select design for update button:  
 

 
 
2.1.7 Marking/Diagram Number selection 
 
Once a scheme is editable, you can select a new marking to plot via the explorer window: 
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Click on the   or double click on a folder to view available 
markings in a group: 

 
 

You can search for a marking by clicking  and entering some 
text then press enter: 
 

 
 
Choose the marking required and the explorer will select the 
item: 
 

 
 
Markings that do not have a TSRGD reference number (or diagram no) but are prescribed by other 
regulations are included in this listing distinguished by their ‘TSRGD’ numbers greater than 9000.  
 
 
 
2.1.8 Refine Marking/Diagram Number selection 
 
Having selected a marking in the explorer click on the item to display the applicable options for that 
selected marking, such as line width, text height, arrow or symbol icon.  
 
Examples: 
 

  
 
 
The default dimensions are automatically set. These can be amended, by selecting the dimensions, arrow 
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type, text options and/or any other relevant information required in order to generate the required marking.  
 
For further guidance on the defined requirements for a particular marking, the TSRGD drawings may be 
viewed by pressing the 'TSRGD Manual’ button on the LineMap Backstage. 
 
Example: 
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2.2 Using the guidelines to draw markings 

 
2.2.1 Guidelines principle 
 

 
Guidelines tools 
 
Guidelines are used to define construction lines from which the road markings are generated. They can be 
found on the DESIGN Tab. They may be drawn freehand by the user or based upon any selectable linear 
item on the base map. Any number of guidelines can be drawn in the construction process.   Only selected 
guideline/s will be used to generate associated marking.  All markings will require one main or ‘orientation’ 
guideline in order to be generated.  Some markings require additional guidelines to assist with outlining the 
limits or region extents of the marking. 
 
The location of the guideline in relation to its resulting marking will vary depending on the type of marking 
plotted.  Some markings are centred about the guideline; others are automatically offset to one side of the 
guideline.  The direction of a guideline when drawn is important as it can govern the position of the result 
marking (see figure below).  
 
 

2.2.2 Road markings (level 1) 
 

2.2.2.1 Single and double yellow lines 
 
Drawing single or double yellow lines can be achieved by using a number of different guideline tools. 
 
Freeform guidelines 
 

If you choose to use the freeform guidelines tool , click on the button to start, then draw the guideline 
on the map by plotting its nodes, double clicking to end the line. Once the guideline has been drawn, use 

the 'Select' button  to highlight it and then press the 'Plot' button .  
 

 

The guideline needs to be drawn following the direction of the traffic flow, in order for the marking to be 
placed correctly.  
 

 
 

 

← WRONG 
 
The guideline (blue) 
was drawn from point 
1 to point 2 (opposite 
direction of the 
traffic) 

 

← RIGHT 
 
The guideline (blue) 
was drawn from point 
1 to point 2 (following 
direction of the traffic) 

 

1 

 

 

 

 

 

 

 

 

 

 

2 

 

 

 

 

2 

 

 

 

 

 

 

 

 

 

1 
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If you make an error and draw the restriction on the wrong side of the kerb line, you can either:  
 
  
Right click anywhere on the mapping and select ‘Clear guidelines’ 

Toggle on the ‘template line for scheme button’ , the template line is a copy of a proportion of the 
originally guideline used to plot the marking.  The default colour of this line is red. 

Select the red template line And click on the re-draw button , the following dialogue box will appear: 
 

 
 

Make sure that ‘Reverse marking’ is ticked and click <OK> or, delete the road marking, by selecting it using 

the delete button . Then redraw the guide line and plot the marking. 
 
 
Generating Guidelines from existing Map features  
 
If a guideline should follow an existing base map feature, such as a kerb line, you can use the ‘plot points 

for route’ guideline . Simply click on the button, click where you want your guideline to start and click 
where your guidelines is supposed to end along the same map feature (kerb line).  
 
You can click as many times as you want along the map feature between the start and end point for very 
long map features. 

Once the start and end points have been placed, press the 'Generate template' button  and a guideline 
will be drawn between these points following the lines selected.  

 

 
 

If a specific distance along the kerb line is required, select the start point and an end point which should be 
separated from the start point by a distance equal or greater than the distance you want to specified. Press 

the third 'Generate template' button  and you will be prompted for the required distance. 

 

 End Point 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start Point 
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These tools can be used to create continuous guidelines even if the map features are not continuous (see 
example below). Example: 
 
If you want to draw a restriction over a part of the drawing where there is no kerb line (A), the ‘plot points 

for route’ guideline  tool can be used. Draw the four guideline points as represented below (B) but 
ensure that you press <Ctrl> while drawing the guideline point number 2. Press the 'Generate template' 

button  and the guideline will be created (C). You can now draw your restriction (D). 
 

    
(A) (B) (C) (D) 

 
 
If you do not press the Ctrl key while drawing the guideline point number 2, LineMap would not be 
able to jump between points 2 and 3, and the following error will be displayed: 
 

 
 

 

1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4 
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2.2.2.2 Parking bays 
 
These markings can be displayed with or without text and may be yellow (1028.4, police, taxis etc.) or white 
(1028.3, 1028.4 disabled, doctor etc.) and can be situated centrally or along the roadside.  
 
Plot a guideline along the kerb line or the centre of the road depending on the restriction that you wish to 
draw. The marking will ultimately be generated to fit the full extents of the guideline and any required text 
will be outlined on each side, as many times as it can be fitted in along the length of the bay (according to 
separation limitations). 
Examples: 
 

 
 
 
2.2.2.3 School keep clear 
 
This is a kerbside marking which means the guide line is generated along the kerb line and the resulting 
marking will be offset from this. 
Select the school keep clear marking from the markings tool bar and specify the relevant text required: 
 

 

Generate a guideline along the kerb in the direction in which the marking is to be generated (i.e. as if you 
were driving along the left hand side of the road) as the marking is generated it will be offset from the 
guideline automatically. 
A school keep clear marking will not fill the guideline completely. According to regulations, its length will be 
rounded to the nearest number of whole zig-zags up to a maximum of four on each side of the text. The 
marking can be generated in one of two ways: 

Using a single guideline – Select the guideline and click on plot marking  tool.  You will be prompted to 
select the alignment of the marking: 
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and the marking will be generated to fit in as many whole zig-zags as it can 

 

 

Using two guidelines – A centralising guideline which is a second shorter guideline crossing the main one 
can also be used to specify the midpoint of the resulting marking. This could be useful if it is intended to 
plot a school keep clear marking centred around a school entrance for example.  Select both guidelines and 
plot the marking (holding down the <Ctrl> key allows multiple selections). 
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2.2.2.4 Mini roundabouts 
 
Select the mini roundabout marking from the markings tool bar and specify the relevant dimensions 
required. Generate a guideline along the road centre line. 

 
 
Once the size of the roundabout is defined, draw a guideline from the desired centre of the mini-

roundabout toward any direction and click on plot marking  tool. 
 

 

 
→ 

 

 
You can rotate the marking by selecting it and clicking on the rotation tool . The angle created by the line 
drawn (dashed line on the example below) from the original guideline will define the angle of the rotation. 
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2.2.2.5 Directional arrows and text 
 
This is a manually defined marking which means the guide line is generated according to the user 
preferences.  
 
Select the adequate directional arrow marking from the markings tool bar. 
 

 or   
 

Use the freeform  guideline tool to draw the direction of the arrow. The road marking will be drawn 
from the beginning of the guideline and the distance will vary according to your specifications. 

 

 

 
→ 
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2.2.2.6 Box Junction 
 

For markings with shapes requiring ‘Hatching’, the system often requires two guidelines: a boundary line, 
and an orientation guideline. The orientation line is used to generate a region of diagonal hatching and the 
boundary line defines the area of required hatching. 
 
Select the adequate box junction marking from the markings tool bar. 

 
 
You could produce the same box junction without drawing an orientation if you proceed as follow: 

• Select the adequate box junction marking from the markings tool bar 

• Draw a boundary guideline using the free-form guideline tool  but double click on the last point 
forming the region (this will allow LineMap to close the polygon that you are drawing and 
consequently create a region) 

• Use the freeform guideline tool  to draw the orientation guideline. 

• Both features (orientation guideline and region) need to be selected in order to plot the marking. 
Highlight the guidelines using the select button, holding <Shift> at the same time to select the 
region. 

• Draw your box junction using the plot marking tool  

• (If the region drawn only has 4 points then an orientation guideline is not required.) 
 

 

 
→ 
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2.2.3 Road markings (level 2) 
 
2.2.3.1 Anti Skid Surfacing 
 
To generate an Anti Skid Surfacing which covers the entire junction or only part of it the steps are the same. 
First select the Anti Skid Surfacing marking from the marking tool bar. 
 

 

Proceed as follows: 

1. Use the 
freeform 
guideline tool 

 to delimit 
the edge of your 
region. 

 

2. Select points on all 
the features that bound 
the region, kerb lines 
and manually plotted 
guidelines using the 
‘plot points for route’ 

guideline tool . The 
start and end points 
must be on the same 
line. 

 

    

3. Click on the 

 tool. This 
will create the 
region in which 
your Anti Skid 
Surfacing will be 
drawn into. 

 

4. Plot the marking by 

clicking on the  tool 

 
 

 

Start point  

 

 

End point 
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2.2.3.2 Give way junctions 
 
This marking must be generated at a junction. Only 2 guidelines are needed to produce the give way 
junction marking. 
 
Select the give way junction from the explorer. 
 

 
 
Ensure that you select the correct details and then draw the 2 necessary guidelines.  
 

 

Direction of the traffic (direction in which 
to draw the guidelines) 
 

The first guideline should follow the 
direction of the traffic and should be drawn from 
one side of the junction to the other. This 
guideline will be used to generate the twin lines 
for the priority and the edge line at the junction.  

The second guideline  should also follow the 
direction of the traffic and should intersect the 
first guideline where you want the twin lines for 
the priority at the junction to stop and will also be 
used to draw the hazard line that will split the 
road. 
 

 

Select these two guideline and press the Plot marking button . 
 
You might notice that some small changes are required to adjust the marking that has been plotted: 

2 
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To manually edit an existing marking, select the Edit tool , and then click 
on the marking that you want to edit.  The edit toolbar will then be displayed.  
An editable ‘copy’ of the marking will be displayed as a solid red feature.  

 

 

 
 
The removal of parts or an entire section can be carried out by either, selecting individual elements that 

make up the marking using , or for by using  tool to select multiple elements.  Selected items will be 
highlighted in blue.  Click on <Delete> to remove the selected item/s.  The original marking outline will still 

be visible underneath and the revised marking will still be displayed in red.  Click on  to save the 

changes, or  to abandon them. 

 

 
→ 

 

<D
elete> 

 

 
→ 

 
 
 

To trim to a marking, you can plot a region that is then used as a ‘cookie cutter’.  Click on  to draw a 

region, then use the  buttons to add or remove items from the marking as shown below.   
 

 
 

 

 
→ 

 

 
→ 
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If the marking extends outside of the road region click on Trim  and the portion outside will be 
removed as shown. 

 
 

 

 
→ 

 

 
→ 

 
 

2.2.3.3 Hatching and tiger tails 
 
Select the right type of hatching from the Explorer. 

 
 
Different options will be available according to which hatching type was selected, such as line and 
separation widths. 
 
Example: 

 

 
 
To plot a tempered or parallel hatching you only need to draw one guideline to define the direction and 
length of the hatching. 

 

 
→ 

 
 or  
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→ 

 
 
To plot the hatching shown below, more guidelines and information is required. 

 
 
The hatching above can be plotted by choosing either tapered or parallel hatching. This will not affect the 
result marking. As described before, you need to draw a guideline that will define the length of the 
marking.  After plotting the first guideline you can either:  

Draw a guideline across the first one, select these 2 guidelines and click on the plot marking button . The 
following dialogue box will appear: 

 

 
→ 
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The interpretation of the dialogue is assisted with the diagrams on the 
right showing how the marking would look under the different options 
for the location of the second guideline (A-E) 
If the option to ‘Adjust centre to fit guideline’ is chosen, the length of the 
central parallel section will be extended to make the marking the full 
length of the main guideline selected. 
 
 

 

 
  
Or,  
If you draw three guidelines, the system will assume that the two cross lines define the ends of the taper 
and that the marking extends for the full length of the longest guideline. 

 
 
Experimenting with these hatching options can be the best way for you to meet specific requirements. 
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2.2.3.4 Zebra crossing 
 
Select the Zebra crossing marking from the marking tool bar and ensure that you enter and select the 
adequate dimensions and option according to the street in which the marking is located into. 
 

 
 
The pedestrian crossing marking can be plotted with as few as one guideline drawn across the road to 
define where the centre is to lie. LineMap will plot all the necessary markings.  
 

 

 
→ 

 
 
If you plot a zebra crossing along a curve or require different approach lengths you will have to use 
more guidelines and options within the relevant dialog boxes, otherwise you might end up with the 

following: 
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In the case of a curved road, proceed as follow: 

• Select the zebra crossing marking from the marking tool bar 

• Ensure that the option: ‘Adjust to fit’ under Zigzag Markings is chosen 

• Draw 2 guidelines: one to define where the crossing will be (see before) and one to define the 
length of the zigzag markings 

 

 

 
→ 

 
 

• Define the number of zigzag markings that you need on each side (3.5 in the example above) 

• Delete the zigzag markings that do not have the requested amount of zigzag (zigzag on the south 
side of the road in the example above) 

• Ensure that you select ‘Save template line as guideline’ while deleting the unwanted zigzag 
markings 
 

 
 

• Select the pedestrian crossing zigzag marking from the explorer 

• Select the template that was previously saved as a guideline and press the plot marking button . 
The following dialogue box will appear: 
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→ 

 
 

• Selecting the right orientation is crucial at this stage. In the example above, the zigzag marking to 
be plotted is the offside edge marking. Ensure that ‘Adjust to fit template’ from the Markings 
length and ‘Exclude’ from First terminal line is selected. Then enter the number of zigzag markings 
wanted (3.5 in this example) and press OK 

• Delete and redraw all zigzag markings according to the method described above for all zigzag 
markings with a different number of zigzags defined previously (3.5) 

• You should obtain the same number of zigzag markings on each side of the road 
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2.2.4 Other type of markings 
 
2.2.4.1 Bus Lane 
 
The bus lane marking needs to be plotted from a specific offset from the kerb line. To do so you need to 

draw a guideline using the offset tool .   
 
In order to offset a guideline or an existing base map feature, select the item and press the 'Offset' button.  
 

 

From the dialog displayed select the required offset 
option, (left, right or both sides) and enter the offset 
distance in m. Blue lines depict the offset guidelines. 
These lines may then be further offset should you need 
to change them. 

 
 
2.2.4.2 Diagrammatic markings 
 
Diagrammatic markings are provided within LineMap for use in public consultations or advanced planning. 
Blocks of colour are drawn onto the map to indicate different types of markings without the need for 
plotting the detailed marking. The diagrammatic markings are therefore easier to distinguish when plotted 
at smaller scales. 
 

 

 

 
 
A standard set of Diagrammatic markings have been configured for the MORE project to match the Physical 
Street Design Toolkit acetates for stakeholder engagement. These are available as solid, outline or striped 
patterns as above. 
 
It is possible to convert these diagrammatic markings into a TSRGD compliant marking without the need for 
re-drawing the guidelines, selecting the correct diagram number and finally re plotting the markings.  In 
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order to work the markings must be ‘linked’ to a TRSGD diagram number or one of the prescribed marking.  
To enable this feature, select the ‘Diagrammatic Settings’ menu option under the ‘Project’ menu.  Chose a 
diagrammatic marking from the dropdown list and then click on the ’Link…’ button.  A list of markings is 
then displayed (ordered by TSRGD diagram number), select the appropriated marking and its required 
properties, such as line width. 

    

You are then given the option to change the text description to be used with the diagrammatic marking. 

 

Once all diagrammatic markings are set, click on the ‘Continue’ button then enter or modify the description 
for the marking, then ‘Continue’ to save: 

 

Click on the ’Unlink’ button to return to the system default settings. 
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To convert the diagrammatic markings, select a marking or number of markings on the map, and then press 

the  button.  You will then be prompted to select the design that the prescribed markings are to be 
stored in.  
 

 

If the marking is linked to the full zebra crossing 
marking (9013), then the crossing will be drawn 
using the full road width.  
 
 
Converting a single marking will allow for all the 
relevant options to be available.  When more than 
one marking is selected, the system will use default 
options.  The ‘School Keep Clear’ as an example, 
would be positioned at the start of the 
diagrammatic marking and if its source 
diagrammatic marking was too long, it would result 
in a gap between the end of it and the start of any 
adjacent markings.  
 

 
 

 

 

 
2.2.4.2 Free Draw Blocks 
 
Specifically configured for the MORE project are Free Draw road use blocks. These items can be used to 
draw street furniture and non-marking related road space areas: 
 

 

 

 
These items are available in the same patterns as diagrammatic blocks. 
 
Click on the item in the Explorer to set or edit the description for a Free Draw block: 
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Click on  
‘Set Description’ 
then enter your 
new description 

 

 
Click Continue to save 

 
Free Draw blocks can either be drawn in manually as a polygon or constructed as a block. 
To construct as a block: 
 

 
 

 
 

Select an item from the Free 
Draw group The tool allows you to 

draw the centreline of the 
block. Double click to finish and 
enter the offset as above 

Note that the total block 
width in this example is 2 
metres 

Click  to plot the 

block, then  to 
remove the guidelines 

 
 
To draw manually: 
 

 

  
Select an item from the Free Draw group 

Use the tool to draw a region. 
Double click to close the region 

Click  to plot the block, then 

 to remove the guidelines 

 
 
2.2.5 Defining a Time of Enforcement 
 
You can define a road use block or marking to be in use for a specific time period. By default all LineMap 
markings are in constant use.  
 
Draw in your marking or road use block using the methods outlined in the previous section. 
Once the item has been drawn click with  to access the attribute information: 
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Use the drop down list Time Ref to select a time of use. If you don’t see the time you require, click on the … 
button to access a list of all times: 
 

 
 
From this dialog you can add new time definitions. 
 
2.2.6 Create a new route 
 
Routes were introduced for the MORE project to display schemes in the context of the feeder route. 
For MORE clients the primary route has already been added by Buchanan Computing to your LineMap 
system. However if you want to add a new route: 
 
SCHEMES > Route Maintenance 
 

 
 
Click Create to define a new route. You will be prompted to draw the centreline of the route on the map 
display. Note you can also create a scheme on this dialogue and associate it with a particular route. 
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Trace the route you want to define and double click to finish: 
 

 

Enter a route description in the first field.  
 
 
Enter a route width. By default this should be 10 
metres. 
 
Click OK and the Route will be displayed on the map, 
buffered to the specified width 
 

 
2.2.7 Attachments 
 
You can add external attachments to a scheme, such as a hyperlink or document at a specific location. You 
can use this facility to link external sources to your scheme such as images, hyperlinks or videos. 
 
HOME > Attachments 
 

 
 

To display or hide the attachments layer toggle the Show  button 

 

 

Click on the map to plot an attachment point then browse 
to the photo or document using the … button. 
 
Use the file type drop down list to choose the document 
type then click OK 

 
   

 

Plot a Google Streetview point by drawing a line in the 
direction of view. Click and hold the left mouse button, drag 
to the viewing angle required then release the mouse 
button then enter a description of the view and click Save 

 
   

 

Click on a photo point to view attribute information 
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CHAPTER 3: EXPORTING DATA 

 
3.1.1 Overview 
 
This section covers links to other software for the MORE project: 
 

 

• Traffweb Publishing 

• VISSIM Export 

 
 
3.1.2 Traffweb Publishing 
 
You can publish data to Traffweb either for Issue Consultation or Design Consultation. For either routine, 
ensure you are in edit mode then choose ADMIN > Traffweb Export: 
 

 
 
Simply choose the type of consultation you want to carry out and click OK to proceed with the export. 
During the export routine data will be streamlined and zipped into compressed files, then transferred to 
the Traffweb server. Publishing of data will take place overnight. 
 
3.1.3 VISSIM Export 
 
To export data to VISSIM, simply choose ADMIN > Design Export: 
 
Select a scheme from the first list then choose the ESRI Shape format: 
 

 
 
Click OK to export to the specified location. 
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CONCLUSION 
 
Overview 
 
On completion of this course you should now be able to use and navigate around the system with ease and 
be able to carry out the following tasks: 

• Adding/maintaining road markings 

• Information retrieval 

• Creating Schemes, Designs and Routes 

• Map output/production 

• Publish to Traffweb 

• Export to VISSIM 
 
Useful Contacts: Buchanan Computing 
 

Support 
 
If you have any problems, issues or queries with regards to using the system please feel free to 
contact our support helpdesk: 

• Tel – 020 8846 3220 

• Email – support@BuchananComputing.co.uk 
 
Help 
 
You can access online help from within LineMap from the Backstage LineMap tab 
 

 
 
Further Training 
 
If you would like to enquire about additional training courses, please feel free to contact our training 
team: 

• Tel – 020 8846 3220 

• Email – training@BuchananComputing.co.uk 
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